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Introduction	to	ImageQuest	

Welcome to ImageQuest! 
 

The ImageQuest product line is a complete enterprise content management system consisting of document/file 

management, forms processing and workflow components.  ImageQuest is designed to facilitate access to and 

the distribution of document-oriented information within your organization.  By putting documents at your 

fingertips and leveraging the related data, ImageQuest will improve efficiency while helping you deliver better 

service. 

Informa Software has a strong commitment to customer service and product quality.  If you have questions, 

please contact an Informa Client Services Representative immediately.  Thanks for using ImageQuest and please 

share your ideas on how we can make ImageQuest better for everyone. 

Please contact us below for technical support and/or troubleshooting: 

Toll Free:  (877) 475-7778 

Outside US:  (407) 215-1291 

Email:  support@informasoftware.com 

Website:  http://www.informasoftware.com 
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Scanning	with	ImageQuest	(OXPd)		

 

ImageQuest integrates with many different models of Hewlett Packard MFP devices by publishing a button on 

the front panel of the device which allows users to easily scan documents into ImageQuest.  These documents 

are sent into a user’s Indexing Queue where they are then manually indexed and saved.  See the ImageQuest 

Administrator’s Guide for a complete list of supported devices and for instructions on how to configure this 

feature. 

To scan with ImageQuest (OXPd), select the IQmfp button on the front panel of the device: 

 

 

 

The next screen will allow you to select an ImageQuest user who will need to manually index this document.    
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Select another user by touching the box where you see the name: 

 

 

 

For example, if “abaker” is not the user you want, touch another name to select a different user: 
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The screen should then change to reflect the new username: 

 

 

 

You can also select various options in the “More Options” section prior to scanning.  The default options are 

shown here: 

 

 

 

Notice that the “Job Build” option is on by default.  This feature allows you to scan multiple batches and 

combine them into one batch.   
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After pressing “Start Scan”, the following screen will appear:  

 

 

 

Once the scan is complete, the screen will prompt you for further actions: 

 

 

 

You can press “Finish” to send the batch to IQ or “Scan” to scan more pages. 
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IQdesktop 

 

IQdesktop is the primary ImageQuest component – installed as a Windows application - used to store and 

retrieve documents.  IQdesktop provides all of the features necessary for document indexing and retrieval and 

also includes advanced features such as document routing, document revisioning, complete document history, 

adding and viewing notes, exporting to folder, etc.   

In addition to basic searching, full-text search is an included component of IQdesktop.  Most common Windows 

file types such as .txt, .doc, .pdf, and .xls documents that are indexed will be available for Full-Text Search.   

 

Launching IQdesktop 
 

Once the user has scanned documents into ImageQuest, the user is ready to launch IQdesktop as shown below.  

Go to Start > All Programs > Informa Software > ImageQuest and click IQdesktop. 
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Note:  If an IQ user has Single Sign-On enabled and is logged into the PC, they will be automatically logged into 

IQdesktop.  Otherwise, they will need to provide a username and password in order to access ImageQuest.   

The screenshot below shows the default layout of IQdesktop’s major features:  “Toolbar”, “Search”, “Indexing”, 

“Lists” and “Import” and “Scan”. 
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Indexing Queue 
 

The Indexing Queue found in IQdesktop is the end-user’s tool to classify and index documents within a scanned 

batch and export the images and their index values to the Cabinet; it also allows users to reassign document 

batches to other users or roles.   

To view the Document Indexing screen, locate the “Indexing” section on the Tasks panel and click “Indexing 

Queue” as highlighted below.   

 

 

 

Note:  The “Add Document” permission is required to allow users to add a document for indexing.  See the 

ImageQuest Administrator’s Guide 11.0:  Manage Users and Roles for information on this feature. 
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The Indexing Queue shows all available document batches for the user logged into IQdesktop as illustrated 

below.  Document batches may be indexed, deleted or reassigned to another user or role. 

 

 

         

The Index feature allows users to save documents in ImageQuest and establish their search criteria with their 

corresponding attributes to effectively and efficiently locate those documents.  To index a batch, highlight the 

batch and select Index from the “Batch” menu or right-click the batch and select Index.   

To reassign a batch to another user or role, highlight the batch and select Reassign from the “Batch” menu, or 

right-click the batch and select Reassign; to reassign all batches, press Ctrl+A to select all and then select 

Reassign.  The Ctrl key can also be used to select multiple batches. 
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In the “Batch Reassignment” window below, use the drop-down menu to select the user or role to reassign the 

selected batch to as demonstrated and click “OK”.   

 

 

 

 
       

By reassigning the batch to a role, every member in that role has access to the document batch in their Indexing 

Queue.  By reassigning to a user, only that specific user has access to the document batch.  Once a user opens a 

batch, it will be locked for exclusive use for thirty minutes.  If the indexing process takes longer than this, the 

lock will be expired and the batch will once again become available for indexing to other users in that role.  Once 

a batch is indexed by a user, it is no longer available for indexing by any other user.   
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To delete a batch from the Indexing Queue, right-click on the highlighted batch and select Delete, or highlight 

the applicable batch(es) and select Delete from the Batch menu as demonstrated below.  The user will be 

prompted with a confirmation window. 

 

 

   

 

 

Note:  The “Delete Batch” permission is required to delete a batch from the Indexing Queue. 
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Indexing and Committing Batches 

 

Document batches are “time-stamped” with the specific time they were scanned.  To choose one of the batches 

to index, double-click it to open the main Indexer screen. 

Note:  Multiple batch selection is NOT available when indexing; only one batch can be indexed at a time.         

The Indexer screen allows a user to view the individual pages of the batch and designate pages as the beginning 

of documents for indexing.  See below to locate the “Pages” and the “Document Window” to “Zoom”, “Rotate”, 

“Print” or “Smooth” the document image.  

 

 

 

The “Pages” pane allows the user to click each page number to view each scanned page.  

The “Smooth Image” button is on by default for better image quality, but may be disabled in order to increase 

performance. 

To make the image larger or smaller in the document window, click and select a size from the “Zoom” drop 

down menu as displayed on the following page. 
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The “Pan” feature, as shown below, gives the user the ability to navigate an image when the zoom function is 

used and only part of the image can be viewed. When enabled from the toolbar, the user can use the cursor to 

move across the document to find the information they are looking for. 
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Click the Rotate 90���� button to rotate the image as displayed on the following page.  This rotation will persist 

when the page is saved in ImageQuest. 

 

 

 

Note:  If Full-Text OCR is enabled, it is possible for a manually rotated page to be orientated so that the text is 

readable by the OCR engine.    

The “Select” feature is a tool of the IQ Smart Indexer process and will be explained later in this document. 

To close the window and return to the Indexing Queue, click  or press the “Cancel” button at the 

bottom of the attribute window. To close the Indexing tab altogether, click  on the right of its tab as shown on 

the following page.  Any changes made to the current batch will be lost once the Indexer is closed. 
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To begin indexing the documents in the batch, designate the first page of the first document by selecting it using 

the <SPACEBAR>.  The  icon will appear to the left of the page number indicating that the page is the 

beginning of the document. The user may also designate the first page by right-clicking on the document page 

and selecting Beginning of Document, as shown below.  
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In the “Document Type” drop-down menu, select the document type to designate the first page of the 

document.  For example, in the screenshot below, the first page of the document is an Invoice. 

 

 

 

Note:  If a “Document Type” is not in the list, see the section for “Managing Document Types” or contact your 

System Administrator. 
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When a document type is selected, the indexing fields for that document type become accessible as shown 

below.  The user will <TAB> through the index fields that appear for the document type; these fields are called 

“Attributes” and become the index values that are used when searching for a document within ImageQuest.   

 

 

 

“Route to” is a system attribute available for every Document Type that allows the user the option to select a 

User or Role to route the document to.  In the screenshot below, “dogden (User)” is selected from the “Route 

to” list for the highlighted Invoice.  If this batch was committed now, a six page Invoice would be routed to 

dogden’s “Work Queue”.     
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Optionally, an email notification can be sent to the “Route to” user or users (if routed to a Role) to let them 

know a document has been routed to them.  See the “Email Routing Configuration” section in the ImageQuest 

Administrator’s Guide for more information. 

“DocumentGroup” is also a system attribute, but will only be available to users that are assigned to at least one 

Document Group in IQadministrator.  Document Groups allow users to organize documents and further restrict 

access to Users or Roles in addition to the permissions set at the Document Type level.  Once a Document Group 

is created and Users or Roles are added, only Users or Roles in that group can assign documents to the group or 

search and view documents assigned to the group.  See “Manage Document Groups” in the ImageQuest 

Administrator’s Guide for more information on managing Document Groups. 

In the example below, the indexing user is a member of three Document Groups, “Atlanta”, “Orlando” and 

“Phoenix”. Each group represents a regional location and the Sales Managers for each location are assigned to 

their respective Document Group.  The first invoice is for Orlando and needs to be assigned to the “Orlando” 

group.  To do this, the indexing user simply selects “Orlando” from the DocumentGroup list during the indexing 

process.  Once the document is committed, only the Sales Managers that are assigned to the “Orlando” group 

will be able to search and view this Invoice. 

 

 

 

As additional documents are indexed, separate DocumentGroup assignments can be made as needed.  If a 

particular document does not need to be assigned to a Document Group, the user does not make a selection 

and the default assignment is (None).  If a document is not assigned to a DocumentGroup, any user or role that 

has permission to the Document Type will be able to search and view the document once it’s committed. 
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If attribute data appears on multiple pages, the attribute data will remain when selecting different pages of a 

document as highlighted below for page 2. This is useful if the index values are located on a page other than the 

beginning page of the document, for example, an invoice total. 

 

 

 

Once the last index field is filled in for a document type, <TAB> to return to the “Pages” pane, or click on the 

next page to index the additional documents with each corresponding document type and completed index 

values as shown below.  For example, Page 4 is the beginning page of another document of the type, “Invoice”, 

with Pages 5 and 6 as attached pages. The attributes and indexing fields, “Customer Name”, “InvoiceDate” and 

“InvoiceAmount” can be filled in for indexing prior to committing this batch.   
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“Clear the current value” allows users to clear attribute information that was entered or selected during a 

search or edit.  This feature is available in all IQ search, edit or indexing windows.  

See below.  To clear a value, click the    button to right of the entry field.  

 

 

              

Note:  This feature is not available for True/False or required attributes in the edit or indexing windows. 

To commit the batch to ImageQuest, click on the “Commit” button, as shown below. 
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The “Confirmation” window appears below; click “Yes”.  The batch will be committed and after a few seconds, 

click “OK” in the “Completed” window.  If you click “No,” you will return to the active batch. 

 

 

 

 

The “Confirmation” dialog box will report the number of documents to be stored in the Cabinet.  Pages without 

icons next to them are not counted as part of the number of documents as illustrated below.  For example, 

Pages 2 and 3 will be attached to Page 1 to the Document Type, “Invoice” highlighted in yellow and Pages 5 and 

6 will be attached to Page 4 to a second Document Type, “Invoice” highlighted in blue.  This results is two 3-page 

Invoice documents being sent into ImageQuest. 

 

 

 

Note:  If required index values were not entered, a “Document Error” screen will show which page and which 

document has the missing value.  Click the “Abort” button to stop the batch commit and make any necessary 

corrections. 
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Once a batch is committed, the user will return to the Indexing Queue to show remaining batches to index as 

displayed below. 

 

 

 

Page Features in the Indexing Queue 

 

The available options on the right-click menu are Beginning of Document, Exclude this Page, Move Page Up, 

Move Page Down and Clear Selection.  See below.  You can exclude a page from a batch by highlighting and 

right-clicking it to select Exclude this page.  When the document batch is committed, the images marked to be 

excluded will not be included with the documents.   
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For example, as shown below, Page 6 has been excluded.  When this batch is committed, we will have two 

documents in ImageQuest:  one, three-page “Invoice” document consisting of Pages 1, 2 and 3 and one, two-

page “Invoice” document consisting of Pages 4 and 5. 

 

 

 

Changing the order of the pages in a batch is also possible by right-clicking on a page and selecting Move Page 

Up (Ctrl+U) or Move Page Down (Ctrl+D) as modeled below.  For example, Page 5 has been highlighted and 

moved up; as a result, the document type, “Invoice”, is now a four-page document consisting of Pages 1, 2, 3, 

and 5, and the second “Invoice” document consists of Page 4 and Page 6. 

 

 

 

Clear Selection, as shown below, is used to deselect a page that has already been designated as a new 

document or that has already been excluded.   
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Training Mode 

 

The Training Mode feature allows focus on areas of the image to increase visibility and ease of indexing.  You 

can use this mode to configure the document template for review.  To enable this mode, click Training Mode 

below the “Indexing Queue” tab.  

Next, select a Document Type and use the Zoom function to change the view of the document.  Under each 

corresponding field, there will be a Save Image Position button as shown below.  

 

 

 

After you zoom in on the desired section of the document, click Save Image Position to save the current position 

or magnification. 

Once the image positions have been saved, click the Training Mode button again to return to indexing.  From 

now on, the trained document type will automatically zoom to the appropriate areas as you tab through the 

attributes.  Trained document types are user and machine specific, meaning that if another user logs into the 

same client PC, the document types will need to be retrained. 

To remove training from a specific document type, enable Training Mode, set the zoom level to “Entire Page” 

and click Save Image Position for each attribute. 
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IQ Smart Indexer 

 

IQ Smart Indexer performs “IQ Smart Indexing” OCR on .tif files in the Indexing Queue to allow for quick “click 

and drag” indexing in the document Indexer.  This feature allows users to index documents more efficiently and 

can reduce, if not eliminate, the need to type data. 

A “Status” column displays the status of the IQ Smart Indexer process for each batch.  See below. 
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There are four different statuses for IQ Smart Indexer.  See below for each icon and its description. 

Status Icon Status Description 

 

Unknown – The batch is in queue for IQ Smart 

Indexer.  IQ Smart Indexing cannot be performed 

on the batch. 

 

In Process – IQ Smart Indexer is currently 

processing the batch.  IQ Smart Indexing cannot be 

performed on the batch. 

 

Completed – IQ Smart Indexer has finished 

processing the batch.  IQ Smart Indexing can be 

performed on the batch. 

 

Failed – IQ Smart Indexer has failed for the batch.  

IQ Smart Indexing cannot be performed on the 

batch. 

                                  

A batch can be opened for manual indexing with any Status, but only batches with a “Completed” Status can be 

indexed with IQ Smart Indexing.  

If a user attempts to open a batch that is “In Process”, they will receive a message box as shown below.   

 

 

 

Clicking “Yes” will allow the user to proceed with manual indexing, but the “Select” tool will be disabled and IQ 

Smart Indexing cannot be performed.  Clicking “No” will return the user to the Indexing Queue and the IQ Smart 

Indexer will continue to process the batch.  Once the Status is “Completed”, the user may re-open the batch and 

perform IQ Smart Indexing. 
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Once the Status for a batch is “Completed”, IQ Smart Indexing can be performed on the batch.  To begin IQ 

Smart Indexing, highlight a batch with a “Completed” Status as demonstrated below and double-click it.  This 

will open the main Indexer screen.   

Note that all the tools for manual indexing (Training Mode, Pages, Zoom, Rotate, etc.) are still available, but the 

“Select” button is enabled as well.  The “Select” button must be enabled and selected in order to use IQ Smart 

Indexing. 

 

 

 

To use IQ Smart Indexing on the documents in the batch, designate the first page of the first document by 

selecting it using the <SPACEBAR>.  The  icon will appear to the left of the page number indicating that the 

page is the beginning of the document.  
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In the drop-down menu, “Document Type,” select the document type to designate the first page of the 

document.  For example, as shown below, the first page of the highlighted document is an invoice which means 

that this page is designated as the first page of the document type, “Invoice”.  

 

 

 

At this time, IQ Smart Indexing can be performed.  Tab to the first attribute to be indexed.  Next, locate the 

desired text in the image displayed in the Document window with the mouse cursor.  Press and hold the left 

mouse button and, from left to right, drag over the text to capture.  Release the left mouse button to populate 

the attribute with the selected text.  In the screenshots on the following page, the user is using IQ Smart 

Indexing to populate the “CustomerName” attribute with the value “Informa Software” by clicking and dragging 

over the text on the image in the Document Window. 
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IQ Smart Indexing will then auto tab to the next attribute so the user can continue indexing the document.  See 

below.  The user has also populated “InvoiceDate” with “11/3/2011” and is in the process of populating 

“InvoiceAmount” with “167.40”. 

 

 

 

Assign and index additional documents in the batch as needed, and click “Commit” to commit the batch to 

ImageQuest.  Once a batch is committed, the user will return to the Indexing Queue to show the remaining 

batches to be indexed. 

Note:  IQ Smart Indexing and manual indexing can be performed on the same document if the Status for the 

batch is “Completed”. 

Searching for Stored Documents  
 

The Search task allows for a wide variety of search options:  “Custom Search”, “Keyword Search” and “Saved 

Queries”; these allow the user to perform a search based on any attribute value, one or more specific Document 

Types, and/or keywords within indexed documents. 
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Custom Search Tab 

To initiate a search for documents, click the Search icon  in the toolbar, use the “Tools” menu to select the 

Search function as highlighted on the next page or click the “Advanced” link. 

 

 

 

All document types are selected by default, so a user can simply enter or select attribute or keyword 

information and click “Search” to search all documents that meet the criteria.   

See the following page.  Users can select which document types to include in a search by checking or unchecking 

document types from a dropdown list.  When a selection is made and the user clicks “OK”, the Search window 

will update to only reflect the attributes shared by the selected document types.   
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As shown below, a search is in effect for an InvoiceDate of 5/19/2009.  By selecting a single Document Type, the 

list of all available attributes is changed to reflect only those attributes associated with that Document Type.  

Click “Search” once the desired index fields are completed.   
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“DocumentGroup” is a system attribute, but will only be available to users that are assigned to at least one 

Document Group in IQadministrator.  Document Groups allow users to organize documents and further restrict 

access to Users or Roles in addition to the permissions set at the Document Type level.  Once a Document Group 

is created and Users or Roles are added, only Users or Roles in that group can assign documents to the group or 

search and view documents assigned to the group.  See “Manage Document Groups” in the ImageQuest 

Administrator’s Guide for more information on managing Document Groups. 

 If the user searching for an “Invoice” document is not a part of a Document Group, the search will only return 

“Invoice” documents without a value for the DocumentGroup attribute.  

When a user is a part of one or more Document Groups, as seen below, and chooses one of those 

DocumentGroup to search by, the search will return only “Invoice” documents with the specified value. When 

the same user leaves “DocumentGroup” blank, the search returns “Invoice” documents with “Atlanta”, 

“Orlando”, and “Phoenix” DocumentGroup values, as well as those invoices not associated with a 

DocumentGroup. 
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The custom search results below returns three Invoices with an InvoiceDate of 5/19/2009.  The IQ search query 

is displayed in each Search tab so users can see the search criteria used for the displayed results. 

 

 

          

When a second Document Type is selected, only the attributes common between the two Document Types will 

be available for search.  Whenever a range of results is possible, the word ‘to’ will appear between the left and 

right attribute fields.  When searching within text fields, the ‘or’ statement means that either or both criteria 

entered (whichever is true for the Document Type selected) will be returned in the search results.   

The wildcard value (*) may be used when exact information is not known, or when broader search results are 

desired.  For example, entering the asterisk at the end of the value like ‘smi*’ means that you are searching for 

any value that begins with the letters ‘smi’.  This search will return both ‘Smith’ and ‘Smithers’, etc.  Placing the 

wildcard at the beginning and searching for ‘*mith’ will return items that end in ‘mith’, like both ‘Smith’ and 

‘Blacksmith’.  Placing a wildcard at both the beginning and the end and entering ‘*mit*’ will return items that 

have ‘mit’ anywhere, like Smithers, Mitchell or Permit, etc. 

Note:  Wildcards cannot be used on attributes that use Input Masks.  This includes integer and numeric 

attribute types. 
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Saved Queries Tab 

 

“Saved Queries” are predefined and configured to allow users to perform common and frequent.  These save 

time, yet are limited to the search criteria established in the query. 

The user may perform a search using the “Saved Queries” method in IQdesktop.  Click the search icon  and 

then, click the “Saved Queries” tab as shown below to select a saved query from the drop down menu.  Fill in 

any required attributes and then click the “Search” button. 
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The screenshot below gives an example of a saved query search based on the “InvoiceDate” attribute and its 

search result.   

 

 

            

 

 

Note:  Saved queries must be configured in  IQadministrator to be accessible from IQdesktop; see the 

ImageQuest Administrator’s Guide for more information on how to configure “Saved Queries”.   

Note:  Wildcard values (*) may NOT be used when inputting the user parameters of a saved query; if Full-Text 

searching is enabled, keywords may be entered in addition to saved query criteria to create a combined 

attribute based and keyword based search.  
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Keyword Search 

 

Another way to search for stored documents is by entering the keywords in the “Keywords” field in the “Tasks” 

panel.  Most common file types such as .txt, .doc, .pdf, and .xls documents are available for Full-Text search; the 

search results will include all documents that contain the keyword criteria entered.   

See below for search string examples and descriptions of valid full-text search syntax. 

 

Search String Example Description 

Invoice  Simple Match  

Invoice OR Fax  OR 

Software Hardware  Implied AND  

Software AND Hardware  AND  

Software NOT Hardware  Implied AND NOT  

Informa*  Wildcard  

(Software AND Hardware) AND NOT Informa  Parenthetical grouping  

"Informa Software"  Exact phrase match  

 

Note:  Wildcard values (*) in the middle of a word (in*ma) are not supported.   

Note:  When using symbols and other non-alpha characters in the Keyword field, it may be necessary to 

enclose the search terms in quotation marks (i.e. “Joe’s Crab Shack”). 

To use “Keywords”, enter the phrase as the search criteria (and any custom or saved query criteria), for 

example, “Informa”, and click “Search”.  See the screenshot on the following page to view the search results 

displaying two documents relevant to the search criteria. 
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Customize List 

 

The Search task in IQdesktop includes a “Customize” feature that allows users to add frequently used search 

attributes to the Tasks panel as “favorites” for quick searching. 

Click the “Customize” link to open the “Choose Favorite Search Attributes” window.  You may select up to five 

attributes to be displayed in the tasks pane.  The user can then enter or select search criteria and perform their 

search directly from the Search panel.  See below. 
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Viewing a Document 
 

Once the search function locates the desired documents, the documents may be viewed.  To view a document, 

double-click it or right-click on it to open the menu and select View Image (Ctrl+I) as illustrated below. 

 

 

            

    

    

    

    

 

 

A document like the sample below is displayed in the user’s default image viewer; this figure shows a PDF file 

opened in Adobe Acrobat Reader. 
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Configuring the View 
 

IQdesktop is highly configurable, allowing the user more screen “real estate” to display the information about 

the documents in a way that is most valuable to the user.  The user also has leverage to emphasize any 

information displayed in each document.  For example, by selecting which data columns are more desirable in 

sorting, grouping, and criteria for filtering.   

IQdesktop is comprised of three main areas by default, the Tasks panel on the left, the search grid on top and 

the Notes/History panels on the bottom as seen below.  This screen can be customized in a variety of ways by 

hiding and closing some or all of the panels or by moving the panels to different parts of the screen. 

 

 

 

To increase screen “real estate”, locate the pushpin icons on the “Tasks”, “History”, and “Notes” panels as 

highlighted on the following page. Unpinning the panels causes them to slide out of the way.  To access the 



  ImageQuest User’s Guide 11.0 

46 

 

hidden panels, simply hover over the tabs.  Click the pushpin again to allow the panels to always be shown on 

the screen.  The panels may also be closed altogether by clicking on the X to the right of the pushpin. 

 

 

  
Another way to increase the screen “real estate” is by moving the mouse cursor between two panels until the 

 cursor shows up.  Once the cursor changes to the double arrow click and drag the cursor to expand the 

panel as shown below.  
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The three panels (Tasks, Notes and History) can also be moved around the screen and customized.  To move one 

of the panels, first make sure that the panel is pinned.  Next, click and drag the panel tab name to one of the 

drop position indicators as shown below.  Release the mouse button when the panel shadow preview appears in 

the location you want.   
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In the example below, the “Notes” panel has been moved next to the “History” panel so both are viewable at 

the same time, as shown here. 

 

 

 

To return to the default window layout at any time, go to the “View” menu and select Default Window Layout 

as illustrated below. 

 

 

 

Panel positions are saved automatically per user/per machine.  If a user changes the view of the screen and logs 

out, once he/she logs back in, the screen view will return. 
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Preview Pane 
 

Beginning with version 11.0, the IQdesktop client now has an additional image preview pane that lets you see 

the document within the client without launching the associated application.  ImageQuest uses built in Windows 

Preview Handlers, the same technology that Microsoft Windows Explorer and Microsoft Outlook use, in order to 

render the preview pane.  The following file types should preview in IQdesktop without the need to install 

additional software:  .bmp, .jpg, .rtf, .txt, and .tif.  Additional preview handlers can be installed as well in order 

to preview other file types.  Installing Microsoft Office 2007 or 2010 will activate previews for .doc, .docx, .xls, 

.xlsx, .ppt, and .pptx while installing Adobe Reader 9 or 10 will activate .pdf files. 

 

 

 

Note:  Documents that are larger than 50MB will not show in the preview pane for performance reasons and 

instead will display a message asking the user to launch the associated application instead. 
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Column Customization 
 

The example below shows a sample of the IQdesktop column headers.   The document grid columns may be 

customized to better meet your needs.  Columns can be moved, removed, added, widened or narrowed. 

 

To move a column header, left-click on the column, drag and release it in the header row where the column is 

desired.  For example, CreateDateTime, as shown below, is being moved from its default location to the right, in 

between PageCount and InvoiceAmount. 

 

 

 

 

 

 

A user can remove a column by left-clicking on the column header to be removed and holding down the left-

button to drag the column out of its initial setting as modeled below.  An X will appear in place of the normal 

mouse cursor.  For example, the column, “Document Group”, is being removed from the header. 
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Release the left button to remove the column.  The column name is deposited in the “Customization Window” 

which stores columns that are hidden from the user. 

To add a column back to the header, right-click on the header row and select Column Chooser from the menu as 

displayed below.  

 

 

             

 

 

The “Customization” window will open.  As demonstrated below, drag the column name from the Customization 

window back to the header row by left-clicking on it, dragging it and releasing it.  In the example on the 

following page, the column, “Document Group”, is returned to the header. 

 

 



  ImageQuest User’s Guide 11.0 

52 

 

Columns can also be narrowed or widened depending on how much column space you require for any column 

displayed as demonstrated below.  To narrow or widen a column, position the mouse across the line dividing the 

two columns until you see   and left-click and drag, moving to the left to narrow or to the right to widen 

the column; the CreateDateTime column is being narrowed in the figure below. 

 

 

 

Best Fit 

 

The Best Fit feature automatically sizes a column to fit the maximum length of data in the column at the time of 

sizing.  To expand a specific column like CreateDateTime to the best fit for viewing, double click between the 

column headings or right-click on the header row and select Best Fit as displayed below.  To expand all the 

columns at once, select Best Fit (all columns) from the right-click header. 
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Sorting 

 

Sorting can be performed on any displayed column in ascending or descending order.  There are two ways to 

define the sort option:  1) click on the header as targeted below to display the results in ascending or descending 

order; 2) right-click on the column header of the column to open the header menu and select “Sort Ascending” 

or “Sort Descending”.  The data in the grid will then be sorted accordingly once you click it.  To clear any sorting 

selection, right-click on the column header and select Clear Sorting. 

 

 

 

Note:  Multiple columns may be sorted by holding the shift key down while clicking additional column 

headers, one at a time. 
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Grouping 

 

IQdesktop allows for the grouping of one or more columns which allows for a different view of the grid.  It also 

shows a row count associated with each attribute value.  There are two ways to group columns:  1) right-click on 

the column header intended for grouping; this will open the header menu as displayed below.  Select Group By 

This Column which moves the column to the Group By Box above; or, 2) click and drag a column header to the 

Group By Box.  Repeat either grouping method as needed to group by multiple columns.  

 

  

To ungroup a column, right-click on the column in the Group By Box and select the Ungroup option, or click and 

drag the column back to the column header as demonstrated here.   
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The grid may be fully expanded or fully collapsed by right-clicking anywhere in the Group By Box and selecting 

the appropriate menu item, as seen on the following page. 

 

 

 

Note:  To clear the contents of the Group By Box, right-click anywhere in the box and select Clear Grouping. 

 

Filters 

 

Filters limit the returned search results and help customize a view to easily locate data.  One or more filters can 

be applied to columns currently displayed in the document grid.   

To apply a filter to a column, left-click on the drop-down menu arrow on the right-hand side of a column header.  

As shown below, the drop-down menu will list all of the values currently displayed in the column for convenient 

selection as a filter.  Once a value is selected, the drop-down menu will close and the display grid will show the 

rows of data that matched the selected value. 

 

 

 

The bottom of the grid now displays the applied filter, ‘5/19/2009’ to the column, “InvoiceDate”, as shown 

above.  To cancel the filter, simply click on the    to the left of the filter.   
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Note:  Multiple filters may be applied to more than one column at a time.   

More complex or versatile filters may be created by selecting the “Custom” option from the drop-down list.  The 

“Custom” option allows the user to create conditions bound by an “And/Or” clause.  When “Custom” is selected, 

the “Custom AutoFilter” window appears as highlighted below.  For example, the user selects “is greater than or 

equal to” and enters a value of 500 to locate documents that contain invoice amounts equal to or greater than 

$500, yet there are several criteria that can be utilized as you view the entire drop-down menu (i.e. “equals,” 

“does not equal,” “is greater than,” etc.).  Click “OK” to apply the filter. 

 

 

 

Save Layout 

 

Once the grid has been customized to your liking (i.e. column sort order, column removal, column order), you 

have the option to save the grid layout.  To save the grid layout, press Ctrl+L or go to the “View” menu as 

demonstrated below and select, Grid Layout > Save Layout; the options to Restore and Forget Saved Layout are 

not available if there is no saved layout.  Once a layout has been saved, you may select Forget Saved Layout to 

delete it and restore the default look.   
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If you have a saved layout and make changes to the grid during your session, you may select Restore Layout to 

revert back to the saved grid layout. 

Note:  The “Indexing Queue” grid layout is saved automatically every time the user exits the queue. 

 

Updating Documents 
 

After documents have been indexed, users may update or edit attribute data as well as revise individual 

documents.  As these changes are made, they are recorded in Document History which serves as an audit trail 

for administrative review.  Reasons for these changes to individual records may be noted in the Notes panel for 

future reference.  

 

Notes 

 

The Notes panel is beneficial to users because it allows for adding comments to a document as illustrated below.  

For example, the outlined document in this figure has a note.  When a note is entered for a specific document, 

the  icon appears in the Note column next to that document.  The Notes and History tabs are located at the 

bottom of the screen; click the Notes tab to view the comments for the highlighted document.  This note, 

‘Additional services rendered—outstanding balance updated’ has been entered on 6/25/2009 at 1:07:26 PM by 

the User “dogden”.  The Notes panel will update automatically as other documents are selected.  If the Notes 

panel has been removed from the view, it may be returned by selecting Notes from the View menu. 
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Note:  Once a note is entered, it cannot be updated or changed. 

Note:  Notes cannot be searched. 

Note:  The “Update Document” permission is required for individual users to add notes.  

 

Edit a Document 

 

To edit a document, right-click on the highlighted document and select Edit from the drop-down menu as 

demonstrated below. You may also use the toolbar icon or the Document menu. 
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The “Edit Document” window appears so that changes may be made to the document as illustrated above.  The 

Document Type for editing in this sample is “Invoice”.  Once the document is updated, click “Save” to save the 

changes; if the user decides that no changes are necessary, click “Cancel”. 

 

 
 

 

Selecting a new Document Type in the drop-down menu will refresh the screen to display the attributes 

applicable to the selected Document Type.  The window below appears to confirm the Document Type change.  

Click “Yes” to proceed.  
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If the new Document Type has attributes that match the original Document Type, the initial data will be 

retained.  Any attributes of the new Document Type that do not match the original Document Type will be 

empty, and the new information can be entered.   

To edit multiple documents, right-click on the highlighted documents and select Edit from the drop-down.  You 

may also use the toolbar icon or the Document menu. 

When more than one document is selected for editing, only the attributes that are applicable to both 

documents will appear.  Check the box next to the attribute you wish to edit, update the index information and 

then click “Update” when finished.  This will update all the records with the new information.  See the sample 

below. 

 

 

Note:  The Document Type field cannot be changed when using “Multiple Document Edit” and must be edited 

individually. 
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Grid Edit 

 

The grid displaying the indexed documents may also be edited directly using   (Ctrl+E) as illustrated 

below.  Toggling the Grid Edit button makes the search grid act much like a spreadsheet program such as 

Microsoft Excel in that you can type directly into the fields.  Use caution while Grid Edit is enabled as changes 

are saved automatically once you click off of the document row.  Fields highlighted in gray are either system 

fields or attributes that are not associated with the document type; these fields cannot be edited. 

 

 

 

Delete or Undelete Documents 

To delete a document, right-click on a record and select Delete, or highlight one or more records and select 

Delete from the “Document” menu as demonstrated below. 
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The “Confirm Delete” window appears to ensure that the user desires to delete the selected document as 

shown on the next page; click “Yes” to proceed. 

 

 

 

The user will then be prompted to enter a note explaining why the document was deleted as noted below.  For 

example, this document was deleted because it was a duplicate document in the grid.  Click “OK” to complete 

the delete process. 

 

 

 

Records deleted from IQdesktop are never actually deleted but are flagged as such, much like the Windows 

recycling bin.  Selecting “Include Deleted” button from the View menu allows a user to show or hide the deleted 

documents if he or she has permissions to do so.  Deleted records have a red   at the beginning of the record 

as shown below.   
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Selecting “Undelete” from the Document menu, as shown on the next page, removes the red  from the 

record and returns the document to its previous, searchable state. 
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The “Confirm Undelete” window appears to ensure that the user desires to undelete the selected document as 

shown here; click “Yes” to proceed. 

 

    

 

The user will then be prompted to enter a note explaining why the document was undeleted as noted below.      

Note:  Users must have the “Delete Documents” permission to delete documents and the “View Deleted 

Documents” permission to search for and display documents with a “Deleted” status.  To undelete a record, 

users must have both of the permissions listed above. See the ImageQuest Administrator’s Guide for more 

information. 

 

Revising Documents 

 

IQdesktop supports the revision of documents so that original files can be replaced with more current files.   

Original files may still be accessed via the History panel (see the following page).   

In a “Search” tab, right-click on the highlighted document and select Add Revision, or select it from the 

“Document” menu as illustrated on the following page. 
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After clicking Add Revision, the user will be prompted to locate a file to update the current record.  The new file 

will replace the existing file.  There is no limit on how many revisions are permitted to a document. 

To view previous document revisions, right-click on any of the “Revision” actions in the History panel and click 

View Revision as shown below.  To see the revision numbers, click the “Show Preview” button. 

 

 

 

Note:  The file type being revised must be the same as the file type intended to be added, except in the case 

of .pdf files which may be .pdf or .tif. 

Note:  Documents that are revised will be re-queued for IQocr.  Only the most recent revision will be full-text 

searchable. 

Note:  The “Update Document” permission is required for revising documents. 
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Document History 

 

Anything that happens to a document, be it user related or system related, gets recorded into the History panel 

making it easy for someone to see exactly who did what and when.  By default, the History panel is located at 

the bottom of the screen underneath the grid.  Highlight a document and click on the History tab at the bottom 

of the screen to see the History panel.  If the History panel was previously closed, selecting History from the 

“Document” menu will bring it back as shown below. 

 

 

 

The History panel shows three columns, “Action”, “Event Date” and “User Name” as seen in the screenshot 

below.  These columns can be sorted just like the main search grid.   
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See the screenshot below, which highlights the History Toolbar features—“Print”, “View Revision” and “Show 

Preview”.  The user may print the history of any document, view its revision (if any) or expand the action details 

to see more information. 
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Scan to ImageQuest 
 

Scan to ImageQuest replaces the IQscan program that shipped with earlier versions of the ImageQuest client 

and should support any scanner that uses a TWAIN driver.  If a user has the “Add Document” permission, they 

will see a link to the scanning application in the “Tasks” pane of IQdesktop.  Clicking the link will launch the 

scanning interface. 

 

 

 

There are two different ways to scan documents into ImageQuest.  The default option is to save the scan to the 

logged in user’s Indexing Queue.  Use this option if you need to use batch processing or if you want to use the 

Smart Indexing feature.  You can also use this option to scan the documents into another user or role’s Indexing 

Queue by changing the selection in the drop down menu. 
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The second option is to assign the index values up front and commit the scan directly to ImageQuest.  Use this 

method if you do not need to use Smart Indexing or if you need the ability for the document to bypass the OCR 

process and remain a .Tif file (optional).  Unlike the IQfolder, this method will not create an “MFP Scan” 

document type. 

To start a new scan using the default TWAIN driver options, simply click the Scan button in the toolbar.  If you 

need to change the source scanner or to select different scanning options, click on the File menu and select 

either Select Source or Scan with Advanced Options.  After the scan is completed, you have several options 

available on the toolbar.  Clicking the scan button again will append pages to the end of the current document.  

Clicking the  icon will add a page before the current page and clicking the  icon will delete the current page.  

Click “Submit” to complete the scanning process or “Discard” to cancel and exit the scanning application. 

 

 

 

Note:  The look and feel of the advanced scanning options is determined by the type of scanner you have and 

the driver that is installed. 
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PDF Annotation 
 

PDF Annotation allows users to add annotations and markups to PDF documents from within the IQdesktop 

client without the need for third party tools.  In order to use this feature, the ImageQuest user must have the 

“Annotate Document Image” permission.  To create a new annotation, right-click on a .PDF file and select 

“Annotate” from the menu. 

 

 

 

The three tabs along the left allow the user to switch between thumbnail view, bookmarks and a list of 

annotations on the document.  Once the document has been saved, it will become the latest revision and the 

new active document when viewing the image.  

 

Note:  Annotations cannot be edited nor deleted once the document has been saved. 
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The following table describes the toolbar buttons that are used in the document editor: 

 

 Saves the annotations and closes the form 

 Pan document tool – click and hold the left mouse button to move the image  

 Select annotations – use this tool to select and edit annotations 

 Select text – click to select text on the page 

 Print – prints the document 

 Previous page 

 Next page 

 Zoom in – click the page to zoom in 

 Zoom out – click the page to zoom out 

 Dynamic zoom – click and drag up to zoom in, drag down to zoom out 

 Marquee zoom – draw a box to define the zoom area 

 Actual size – zoom to the actual size of the document 

 Fit entire page – zoom to fit the entire page to the viewer 

 Fit width – zoom to fit the document width in the viewer 

 Fit height – zoom to fit the document height in the viewer 

 Rotate left – rotates the page 90 degrees counter-clockwise 

 Rotate right – rotates the page 90 degrees clockwise 

 Single page layout – display a single page at a time in the viewer 

 Continuous page layout – display pages as a list in the viewer 

 Two columns – display the pages in two continuous columns 

 Comment – creates a comment annotation 

 Text box – creates a text box annotation 

 Stamp – creates a predefined rubber stamp annotation such as DRAFT or CONFIDENTIAL 

 Black box – creates a solid black box annotation 

 Rectangle – draws a rectangle annotation 

 Ellipse – draws an ellipse annotation 

 Line – draws a line annotation 

 Arrow – draws an arrow annotation 

 Ink pen – draw freehand ink pen markings on the page 

 Highlighter – draws a yellow opaque highlighter box annotation 

 File attachment – embed a file attachment annotation into the document 
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Work Queue 
 

Formally known as the Route List, the Work Queue displays a list of documents that were either manually 

routed from another IQ user or were automatically created by a notification rule that was setup by the IQ 

administrator.  Documents that were routed to a role will be visible to all members of that role.  The Work 

Queue can be used to process documents that require some type of intervention.   

 

 

 

For example, a notification rule can be created which searches for invoices that need to be paid by the invoice 

due date, and then sends the document to the Work Queue ten days before the due date occurs.  All documents 

in the Work Queue will stay there until the work item is manually completed by a user.  In this example, one of 

two things needs to be changed in order to process the document:  Either the Invoice due date needs to be 

extended beyond the 10 day notification period, or the Paid attribute needs to be updated to true.   
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To process a document in the work queue, right-click on the record and select “Complete Work Item”.   

 

 

 

A window will open which looks exactly like the edit document screen.  The main difference is that saving these 

changes will cause the document to be removed from the work queue, even if nothing has been modified.   

Note:  If you complete the work item and do not change any of the attributes, it could possibly reappear again 

if it still meets the criteria of a notification rule. 

 

There is a special column in the Work Queue called “Action” that shows how the document arrived.  It will either 

show the name of the notification rule that was responsible for routing the document, or it will display a 

message that indicates it was manually routed to a specific user or role.   

It is also worth noting that a single document can be displayed in the Work Queue multiple times for different 

reasons and each instance needs to be processed separately.  Also, users must have the Update Document 

permission in order to complete work item requests. 

Note:  The delete function in the Work Queue functions the same as it does from the search grid.  If you 

delete a document from the Work Queue, it will be flagged as a deleted document and will no longer show up 

in search results.  The Complete Work Item option is the only way to remove the document from the Work 

Queue properly. 
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Find Similar Documents 
 

Find Similar provides an easy way to perform searches based on the results of a previous search query.  For 

example, a search is performed which returns a list of paid invoices for the current month.  What if a user wants 

to search for all invoices from a particular vendor that are displayed in the search results?  If a user right-clicks 

on the “Vendor” attribute cell in the grid and selects “Find Similar”, a new dialog box will pop up. 

 

 

 

 

 

 

 

 

 

 

 

Notice that “Vendor” has been automatically checked.  If the user had right-clicked on the “Invoice Number” 

cell, that field would have been checked by default instead.  Clicking the search button at this point would do a 

new search where “Vendor” is equal to “Sam’s Electrical”.   Additional attributes can also be selected as well to 

“AND” the results together. 
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New Search Tab 
 

The New Search Tab is beneficial to the user if they are managing two or more searches concurrently.  A user 

may open a New Search Tab by clicking the “New Search Tab” button in the toolbar as highlighted below.   

 

 

 

Once the New Search Tab is selected, a “Search” window appears to initiate a new search via “Custom Search” 

or “Saved Queries” as illustrated below; in this figure, for example, the new search is initiated via the “Custom 

Search’ for an Invoice with the customer name “Erin Grant”.  Click “Search”. 
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The new search results are displayed in a new search tab as illustrated here.  The user may switch between the 

tabs to view the different search results.  Currently, an unlimited number of search tabs may be open.  To close 

a search tab, click the  button as highlighted below. 

 

 

Save Local Copy 
 

“Save Local Copy” allows IQ users to save documents from IQdesktop to their client PC or a network location.   

To save a local copy, right-click on a document and select “Save Local Copy.  A Windows “Save As” dialog will 

open and the user can then save the document to the desired location.   
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Note:  Save Local Copy supports single document saves.  Please use Export to Folder for multiple document 

saves if required. 

Email Document 
 

“Email Document” allows users to email IQ documents as attachments using their default mail client. 

To email IQ documents, right-click on the selected document(s) and select “Email Document”.  See below. 

 

 

 

The default email client will open a new window with the selected document(s) attached.  The screenshot below 

shows an Outlook Express message with “Invoice (Revision 1).pdf” as the attachment.  The user can now 

complete and send the message with the IQ document attached. 
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Note:  Email Document requires a compatible MAPI client (i.e. Outlook, Outlook Express) to function. 

Watch List 
 

The purpose of the Watch List is to bookmark a document for future reference instead of having to search for it 

again.  To watch a document, highlight it and select “Watch Document” from the right-click menu or from the 

“Document” menu.   

The “Watch List” may be accessed from the “Tasks” pane or from the “Tools” menu as demonstrated below.  

 

 

 

The Watch List opens in its own tab as shown below and is specific to each user. 
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To stop watching a document, select Stop Watching from the “Document” menu or from the right-click menu. 

 

 

Export to Folder 
 

The Export to Folder feature allows documents selected in IQdesktop to be exported to a folder on the user’s 

PC; an HTML page with searchable metadata is also created.  The user can then manually copy them to 

removable media if necessary.  This creates portability for the set of documents selected for reference outside 

of IQdesktop. 

Only the documents selected in the current grid will be flagged for export.  Hold down the CTRL key while 

clicking individual documents to select individual documents or press CTRL+A to highlight all of the documents in 

the grid.  Once all the documents have been selected, go to the “Document” menu and select “Export to Folder” 

to export the selected documents to a folder as demonstrated below. 
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The “Browse for Folder” window appears allowing the user to either select an existing location, or to create a 

new folder.   In the screenshot below, selected documents will be exported to “C:\AllFiles\MyExportedFiles” 

folder.  Click “OK”. 

 

 

The selected documents have now been exported to the “C: \AllFiles\MyExportedFiles” folder as noted below.  

Click “Yes” to view the exported information. 
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The window below displays the exported documents in a searchable html file (default.hta).  Click the “View” 

hyperlink to view the documents in their native viewer. 

 

 

Note:  Searches performed from the default.hta file are case sensitive. 

Duplicate 
 

To create a duplicate copy of a record, highlight the record and select Duplicate from the right-click menu or 

from the “Document” menu as illustrated below. 
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The Duplicate Document window will open as shown.  The duplicate record Document Type and attributes may 

be edited before clicking “Save”.   

 

Note:  Users must have the “Add Document” permission to create duplicate records. 

Show Associated 
 

When documents are scanned into the Indexing Queue, they arrive with a document type of “MFP Scan”.  After 

a document batch has been indexed, it may be useful to see the original scanned batch.  To show the original 

MFP Scan document batch, select Show Associated from the “Document” menu as displayed. 
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All associated documents, if any, will appear in their own tab.  Associated documents display the   icon next to 

them as shown below.   

 

 

 

Note:  Users must have Allow access to the “MFP Scan” document type in order for them to appear as 

associated documents.   

Note:  Duplicate records are also linked together by using “Show Associated”. 

 

Import A File 
 

Import allows users to browse for and select a file from a client PC or network location and import the file as a 

document to IQdesktop.   

To import a file, click the  button to launch a Windows “Open” dialog.  See below.  Locate and select the file 

to import and click Open. 
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The “Import file” field will display the file path of the selected file.  Click “Import” to launch the “Import To 

ImageQuest” indexer and assign a Document Type and attribute values.  See the following page for an example.  

Click “OK” to import the document to IQdesktop.   
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An “Import Successful” message will confirm the import is complete, as shown below. Click on “OK” to continue. 

 

 

 

Users can also “drag and drop” files to the Import file field and then import the document to IQdesktop. 
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Managing Document Types 
 

Document Types and Attributes may be added and edited from IQdesktop if the user has Allow permissions to 

“Manage Document Types.”  This feature is convenient for users and also allows administrators to give certain 

users access while still restricting them from other administrative functions that require the use of 

IQadministrator.  To Manage Document Types from IQdesktop, select it from the “Tools” menu as shown below. 

 

 

 

The screenshot below highlights the Manage Document Types tab which is the same screen that appears in 

IQadministrator.  For more information on Manage Document Types, see the ImageQuest Administrator’s 

Guide. 
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Additional	ImageQuest	Client	Applications	

 

In addition to IQdesktop, there are three other client applications that may be used to get documents and files 

into IQ: 

• Microsoft Windows Explorer Connector 

• Microsoft Office Connector 

• IQprinter 

 

Microsoft Windows Explorer Connector 
 

Many users have electronic files that need to be stored in ImageQuest.  For this purpose, ImageQuest can use 

Windows functionality to initiate processing electronic files.  To do this, locate and highlight the file or files 

intended for filing in ImageQuest.  Right-click on the highlighted files and select “Send To ImageQuest”  

 

 

  

The “Send to ImageQuest” window appears allowing the user to select a Document Type from the drop-down 

menu and assign attributes as shown on the following page.  Click “OK” to submit the file to IQ.  
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The “ImageQuest Connector for Windows Explorer” window prompts the user that the document has been 

successfully saved to ImageQuest.  Click “OK”.    

 

 

 

Note:  Users must have the “Add Document” permission in order to use the Microsoft Window Explorer 

Connector. 
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Microsoft Office Connector 
 

ImageQuest provides an add-in for several Microsoft Office programs which allows for sending and in some 

cases opening documents from ImageQuest.  The following Microsoft applications are supported: 

• Microsoft Word 2003 - 2010  

• Microsoft Excel 2003 - 2010  

• Microsoft Outlook 2003 - 2010  

Note:  The Office Connector for Microsoft Office 2010 is only compatible with the 32-bit version. 

Other Microsoft file types can to be sent to IQ using the Windows Explorer Connector; see the previous section 

for more information. 

The Microsoft Office Connector for Microsoft Word and Microsoft Excel installs a new toolbar with two new 

icons, one for saving files to IQ and one for opening files from IQ. 

For example, create a Microsoft Word document that you wish to save in IQ as displayed below.  See the 

highlighted Save to ImageQuest icon in the new toolbar; click the icon to save the file to IQ. 
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The “Save Changes” window appears allowing the user to “Add a Revision” or “Create a New Document” as 

demonstrated on the following page.  Since this is a new document, adding a revision to an existing document is 

not possible so the option is disabled.  Select the Document Type and assign attributes; click “OK” when finished.  

The file is now saved to IQ and is searchable from IQdesktop using the index information. 

 

 

 

Now that the document is stored in IQ, it may retrieved using IQdesktop or by using the Open from ImageQuest 

button from the ImageQuest Toolbar as seen on the following page.  Clicking the Open from ImageQuest button 

brings up a new window allowing you to search for documents as well as access your Watch List and Work 

Queue. 
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To find the document we saved earlier, click on the “Search” icon and enter the appropriate attributes and click 

the “Search” button.  See below.   
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The search results will be displayed in the grid.  Double-click on the record or highlight the record and click the 

“Open” button as shown below to open the document. 

 

 

 

If we now make additional changes to this document and click the Save to ImageQuest button, the “Add a 

Revision” is now enabled.  The index information will be automatically populated and may be changed if 

necessary.  Click “OK” to send this revised document to IQ. 
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When a document is revised, the Document Type and all associated attributes on the “Save Changes” screen will 

replace the existing document metadata.  Any previous versions of the document can still be accessed from the 

History panel by highlighting the “Revision” action and clicking on the “View Revision” button as shown below. 

 

 

 

Note:  Microsoft Word and Excel 2007 & 2010 both function the same as the 2003 versions; however, the 

icons are located in the ImageQuest ribbon.   

Note:  Only the most recent document revision can be opened directly from Microsoft Word or Excel. 

 

 

The Microsoft Office Connector for Microsoft Outlook differs from the Microsoft Word and Excel Connectors in 

that it allows the user to save emails and/or attachments into IQ and there is no option to open from IQ.  The 

Microsoft Office Connector for Microsoft Outlook installs a new toolbar with one button called “Send to 

ImageQuest”.  This button has two options, “Entire Email…” and “Attachments Only…”. 
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To store an email message in IQ, open Microsoft Office Outlook and locate the Send to ImageQuest icon in the 

toolbar as highlighted below.   

 

 

 

To send the entire email to IQ, highlight the email in Microsoft Outlook, click Send to ImageQuest and select 

“Entire Email…”.  The Send to ImageQuest window appears allowing the user to select a Document Type and fill 

in the associated attributes as demonstrated below.  Click the “OK” button when finished. 

 

 

 

A message box will appear saying that the file was saved successfully to IQ.  The email message is now 

searchable from IQdesktop. 

To send one or more attachments without the main message body, follow the same steps, but this time select 

“Attachments Only…” from the Send to ImageQuest toolbar.  
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The “Choose Attachments” window appears allowing the user to select which attachments get stored in IQ as 

modeled below; click “OK”.  In the example below, three file attachments will be selected to send to IQ.  All 

three attachments will receive the same index information. 

 

 

 

The Send to ImageQuest window appears allowing the user to select a document type and fill in the associated 

attributes as seen below.  Click the “OK” button when finished.  A message box will appear saying that the files 

were saved successfully to IQ.  These attachments are now searchable from IQdesktop. 

 

          

Note:  Users must have the “Add Document” permission to send new documents and the “Update Document” 

permission in order to add a revision to an existing record in ImageQuest using the Microsoft Window Office 

Connector.  
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IQprinter 
 

IQprinter allows virtually any application to send documents to IQdesktop as a PDF file.  After installation, a 

virtual printer called IQprinter is created as shown below. 

 

 

 

IQprinter can now be selected from a Windows Print dialog as shown below.  

 

   

 

Note:  The IQprinter default page size is 8”x11”; click “Properties” in the print dialog to adjust the page size if 

needed. 
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IQprinter will launch a “Print To ImageQuest” screen as shown below.  Select a Document Type, provide index 

values and click “OK” to send the document to IQdesktop. 

 

 

 

A confirmation will appear when the send is complete.  See below.  Click “OK” to close the “Print To 

ImageQuest” screen.  

 

 

 

Note:  Users must have the “Add Document” permission in order to use IQprinter. 
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ImageQuest Assistant 
 

The ImageQuest Assistant is a program that runs in the Windows system tray and monitors changes made to 

PDF files that are opened from IQdesktop and saves revisions back to ImageQuest.  To use this feature, a PDF 

authoring program must be installed and configured as the default PDF file handler in Windows such as Adobe® 

Acrobat® or Foxit® PDF Editor. 

After editing a PDF file that was opened via IQdesktop, click “save” or simply close the program and answer yes 

when prompted to save the file.  The ImageQuest Assistant will pop up asking if you want to add a revision to 

ImageQuest. 

 

 

 

After clicking “Yes” to save the revision, a message notification will appear in the system tray letting you know 

that the changes were successfully saved to ImageQuest. 
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